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This guide is current as of v 4.4 of the plugin, March 2017.

While some general aspects of SEO will be touched on in this guide in the course of explaining
the plugin, beginners may find that they need a more fundamental understanding of how SEO
works in general, in order to get the best use out of this plugin. | have written an ebook that

addresses that need:
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Yoast SEO is on most lists of 'must-have' WordPress plugins. But the extensive set of options it

provides can seem intimidating, especially to newer users.

Yoast has a fair amount of commentary and explanatory text throughout the plugin screens so |

won't duplicate anything he's saying there, but I'll try and clarify the less obvious parts.

If you’ve used an older version of Yoast on a site, there are several menu tabs you'’re used to

seeing, that are hidden by default on first activation of more recent versions.

To access all of the settings referred to in this guide, you will need to activate the Advanced

settings.

You will know if you've already activated this by the menu ﬂ SEO @

options available. If you have not activated Advanced, you will

Dashboard

only see Dashboard, Search Console and Go Premium on the left.
Search Console

] > > .
If that's the case, go to Dashboard > Features > Advanced settings O Bk

pages and click Enabled:
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© Help center v

Features

Yoast SEO comes with a lot of features. You can enable / disable some of them below.

Advanced settings pages

e advanced settings include site-wide settings for your titles and meta descriptions, social metadata, sitemaps and much more.

s
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SEO > Dashboard

This tab will display problems and notifications to alert you of potential issues on your site:

Dashboard General Features Company Info Webmaster Tools Security

© Helpcenter v

Yoast SEO Dashboard

© Problems (2)

We have detected the following issues that affect the SEO of your site.

Huge SEO Issue: You're blocking access to robots. You must go to your Reading Settings and X
uncheck the box for Search Engine Visibility.

You still have the default WordPress tagline, even an empty one is probably better. You can fix this in X
the customizer.
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SEO > Dashboard > General

From here you can access the configuration wizard and restore the default plugin settings.

Configuration wizard

This “wizard” provides a 10-step process to configuring a few key settings in the plugin. | don't
personally find it that useful, but your mileage may vary. There’s nothing here that can’t be

accessed through the normal settings screen, so this is not a mandatory process.
Steps 4 - 9 are the most pertinent.
[link to sections]

Step 4 Company or Person

Step 5 Social Profiles

Step 6 Post Type Visibility

Step 7 Multiple authors
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Step 8 Google Search Console

Step @ Title Settings

SEO > Dashboard > Features

Readability Analysis

This tool gives suggestions about the readability of your content - how hard or easy it is to
understand efc. It favors easy to understand text - short sentences and a reading level
appropriate for 13 - 15 year old students, based on the Flesch measure. | personally don't use

this feature because | think my audience has a higher reading and comprehension level.
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Once disabled, it will remove this section from the Yoast SEO box on post/page edit screens:

Yoast SEO

© Helpcenter v

| O @ Readability @ Enter your focus ke... +

<
%

= Analysis Q

The text does not contain any subheadings. Add at least one subheading.

The copy scores 32.9 in the Flesch Reading Ease test, which is considered difficult to
read. Try to make shorter sentences, using less difficult words to improve readability.

0% of the sentences contain a transition word or phrase, which is less than the
recommended minimum of 30%.

@ None of the paragraphs are too long, which is great.

@ 0% of the sentences contain more than 20 words, which is less than or equal to the
recommended maximum of 25%.

© 0% of the sentences contain passive voice, which is less than or equal to the
recommended maximum of 10%.
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Keyword Analysis

This tool enables you to enter the keyword or phrase for a given post and the plugin analyzes
your content to see how well you've optimized for it. If you are just learning about SEQ, it can
be useful, although a lot of people misuse it. | explain how to use it properly in the section

dealing with optimizing individual pieces of content.

Once disabled, it will remove this tab:
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@ Readability ® Keyword: Jelly beans | +

@ Snippet preview Q

Jelly beans biscuit cotton candy - WordPress Playground
www.wordpress.dev/jelly-beans/ v

Sugar plum liquorice dragée donut brownie jelly-o cheesecake sweet roll pastry. Cheesecake tart biscuit
jujubes tiramisu.

0 E & Edit snippet

&, Focus keyword (7]
Jelly beans
= Analysis (7]

@ The text contains 96 words. This is far below the recommended minimum of 300 words.
Add more content that is relevant for the topic.

The focus keyword doesn't appear in the first paragraph of the copy. Make sure the topic is
clear immediately.

A meta description has been specified, but it does not contain the focus keyword.
The images on this page do not have alt attributes containing the focus keyword.

You have not used the focus keyword in any subheading (such as an H2) in your copy.
No links appear in this page, consider adding some as appropriate.

The length of the meta description is sufficient.

The page title has a nice length.

The focus keyword appears in the URL for this page.

You've never used this focus keyword before, very good.
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Advanced settings pages

Enabling this will give you back all the features you are used to seeing in the Yoast plugin if

you're a long-time user.
You can also enable / disable the Admin bar menu
OnPage.org

Enable / disable the onpage.org indexability check. This performs some tests to make sure

everything is OK with your site and verifies that it's available for indexing:

"They fetch the homepage of your Domain and check a couple of things in order to make sure,

everything is fine with your site."”
More info on the specifics: https://en.onpage.org/lp/yoast/faq/

| personally have never had the need to turn it off, but should it cause any issues, you can
disable it. Per the link above, issues generally involve false positives, rendering the feature

useless in those cases.
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SEO > Dashboard > Company/ Your Info

The website name is for display in mobile search results. Previously the domain name would be
displayed, but now you can choose your website name instead. See screenshot below. Currently

it's only used in mobile results, but it's possible it could port to desktop in the future.
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Company or Person
This is used only for Google's Knowledge Graph. The Knowledge Graph is part of structured
data, (https://developers.google.com/search/docs/quides/intro-structured-data), specifically to

provide at-a-glance information in search results for certain 'authorities’.

For example, if you do a search for a brand, you'll likely see a Knowledge graph card in the

results:
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BedBathandBeyond.com - Bed Bath & Beyond
X} www.bedbathandbeyond.com/ v

4.6 Yk ¥ rating for bedbathandbeyond.com

Shop The Brands You Love & More. Free Standard Shipping Over $29! KnOW|edge graph Bed Bath & <

Free Shipping On Returns - America's #1 Registry - Buy Online Or In Store Beyo nd %ED BATH &
Buy Gift Cards Great Values & Closeouts card -* - ONID
50% Off Holiday Clearance Create a Wedding Registry ey

Bed Bath & Beyond: Bedding, Bath Towels, Cookware, Fine China ... €  bedbathandbeyond.com

https:/www.bedbathandbeyond.com/ v
Shop Bed Bath & Beyond for bedding, bath towels, kitchen electrics, cookware, cutlery, coffee makers &

K-Cup Packs, window treatments, storage items, gifts ... Bed Bath & Beyond Inc. is an American chain of domestic

merchandise retail stores in the United States, Puerto

Lo Rico, Canada and Mexico. Formed in 1971, the stores sell
el Q goods primarily for the bedroom and bathroom, as well as

kitchen and dining room. Wikipedia

Wedding & Gift Registry Find A Store .
Bed Bath & Beyond's Bridal Registry Use BedBathandBeyond.com to help Customer service: 1 (800) 462-3966
(Wedding) and Gift ... find a store convenient to ... Stock price: BBBY (NASDAQ) $40.64 +0.20 (+0.49%)
Jan 10, 10:04 AM EST - Disclaimer
Bedding Bed Bath & Beyond Culver City Headquarters: Union, NJ
Sleep tight with bedding sets and Get Directions to Bed Bath & Beyond CEO: Steven H. Temares (Apr 2003-)
comforters from ... 10822 Jefferson ... d
Number of locations: 1,504
Subsidiaries: Buy Buy Baby, Cost Plus World Market, More
Top stories Founders: Warren Eisenberg, Leonard Feinstein

Profiles
BED%\TH & BED BATH & & 0 0 B
BEYQ an Facebook LinkedIn Twitter Google+
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SEO > Dashboard > Webmaster Tools

Yoast provides a very handy way to verify your site with Google Search Console (formerly
Webmaster Tools), Bing webmaster tools and Yandex. Alexa used to be available here but

Alexa themselves retired their "claiming” feature, so it's no longer needed in the plugin.

Each of those services will give you a meta tag to paste into your code as a method of proving
your ownership of your website. However by pasting the meta tag here you can save yourself

the need to touch any code — the plugin will add the code for you.

Google Webmaster Tools is a must-have account since it will give you useful information about

the health of your website, and will provide enhanced info inside your Google Analytics account.

Bing webmaster tools also provides some helpful info, including a good keyword research tool.

Yandex is Russia's biggest search engine.

Below you can see the meta tag that Webmaster Tools provides you. The underlined part is
what you will paste into this field of the SEO plugin (although even if you paste in the whole

thing, the plugin is smart enough to clean it up for you ;) ).
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Recommended method Alternate methods

® HTML tag
Add a meta tag to your site's home page.

1. Copy the meta tag below, and paste it into your site's home page. It should go in the <head> section, before the first <body> section.

<meta name="google-site-verification" content="UMGkA7euVeXJCxhtjBkvcoyxkP5a_2vWkQ|CIsSGwYXA" />

» Show me an example
2. Click Verify below.

To stay verified, don't remove the meta tag, even after verification succeeds.

SEO > Dashboard > Security

If you are an advanced user, enable this since it allows you to noindex pages and a few other
things. If you don't need it, you can disable it, particularly if you have multiple users on your site
that might wreak havoc with this. Below is a screenshot of the box that will be added when this

option is enabled.
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Yoast SEO -
© Helpcenter v W Go Premium
D Advanced
< Meta robots index
I 'a' 1 Default for this post type, currently: index v
Meta robots follow
e folow | ' nofollow
Meta robots advanced
| x Site-wide default: None |
Advanced meta robots settings for this page.
Canonical URL
The canonical URL that this page should point to, leave empty to default to permalink. Cross domain
canonical supported too.
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SEO > Titles & Metas

SEO > Titles & Metas > General

Force Rewrite
You will only see this option if your theme does not declare support for the native WordPress

'title-tag' feature. This will likely only happen with older themes.

This is a bit of a technical setting, which may be necessary to activate depending on your theme.
Sometimes there's a conflict between the Yoast SEO plugin and your theme which may also be
outputting some SEO info. The typical indication of this is duplication of information being

output:

<title>WordPress Beta Just another WordPress siteWordPress Beta Just another WordPress site</title>

P L B DO Sl ey | —— = BRI WL S ML A B SSSSRAS ISR RASSIE S B & B B I~

So if you have strange output like this you will need to check the "Force rewrite titles" box to

resolve the problem.
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Title Separator
This is a purely aesthetic setting to determine how you want your meta tags to display in the

search results. The symbol you choose separates the post title from the site name in the meta

tag.

e.g. Post Title | Your Site Name :

Maintaining Your WordPress Site | Web Training Wheels

webtrainingwheels.com/maintaining-your-wordpress-site/ v
Keep your WordPress site safe, secure and running smoothly. Includes a free, downloadable checklist.

-=- OfF --
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Post Title - Your Site Name

Configuration Guide For Yoast SEO - Yoast Knowledge Base

https://kb.yoast.com » WordPress Plugins » Yoast SEO v
Nov 2, 2016 - After you have installed Yoast SEO, you will have a new menu available to customize your

SEO global settings. The plugin also adds SEO settings at the post, page and taxonomy level. Log in to
your WordPress website. When you're logged in, you will be in your ‘Dashboard'.

SEO > Titles & Metas > Homepage

This, and the next few tabs are the places where people tend to get confused. Before we look

at the configuration details, there are a couple things to understand.
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First, one must understand that one of the major purposes of this plugin is that it allows you to

control the meta information for each piece of content on your site, in all the ways that

WordPress displays it (homepage, single post, tag archive, category archive etc)

Secondly, "titles & metas" refers to the meta title and the meta description which determine how

your site's pages/posts appear in Google search results:
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WordPress Plugins by Yoast | e Meta Title

Yoast offers several WordPress plugins built by Joosjfde Valk to optimize your
WordPress SEO, track its performance and tweak #ie minor usability issues power ...

WordPress SEO Tutorial * The Definitive Guide * Yoast

-l v oo - - i g

by Joost de Valk - in 17,336 Google+ circles - More by Joost de Valk
Oct 27, 2012 — This is the ONLY tutorial you'll need to hugely increase your
search engine traffic by improving your WordPress SEO. Plugin, theme & site

Why can | only use one focus keyword in WordPress SEO? » Yoast
yoast.com» SEO

Feb 21, 2013 — You can only chose one focus keyword for a post in our WordPress
SEO plugin. This post explains why you really don't need more than one.

W\ e |
WordPress SEO « Archives - Yoast Meta Description
oast.com/tag/wordp ss-seo/ &

Dec 12, 2012 — Today is the first result of what might become a somewhat longer
tradition: WordPress SEO is now a Sucuri Safe Plugin. What this means? It...

WordPress SEQO, more secure than ever before. * Yoast

yoast.com » WordPress

by Joost de Valk - in 17,336 Google+ circles - More by Joost de Valk

Dec 7, 2012 — What this means? It means I've asked Sucuri to do a full security review
of my WordPress SEO plugin. They found a couple of small issues, ...
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What is a meta description or meta title template?

Ideally you would handcraft the title and description for every single page or post. But if you're
only starting this process when you already have a lot of content not yet optimized, or perhaps
you have authors who you think won't fill it in, the templates you can create in this section allow
something to be output in the event you don't handcraft it, or if you just want to "set it and
forget it". So at least you will be providing some information to Google rather than nothing at

all.
The template is created by replacing the variables you see with the content from that post.

So for example, %%title%% will be replaced with the title of the post or page in question.
%%sitename %% will be replaced with whatever you have designated as your site title in
Settings > General > Site Title and %%sep% % will be replaced with the symbol you chose as

the separator in the General tab.

So if your Posts Title template is this:

Need to learn SEO fundamentals? The Beginner's Guide to SEO for Business 24
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General Homepage Post Types Taxonomies Archives Other

@© Help center v

Posts

Title template: % %title% % % %page% % % %sep% % % Y%sitename% %

The output will look like this:

% Yotitle%% O/OO/OSepo/OO/O %%sitename%%
Image Positioning | WordPress Playground

www.wordpress.dev/image-positioning/ v
Marzipan topping chocolate pastry. Chocolate bar apple pie bear claw. Sweet roll caramels gummi bears

muffin muffin. Candy caramels pudding. Carrot cake ses
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The description defaults to pulling the first couple lines of text from the post/page.

All the possible variables are found by clicking the Help center tab. The defaults that the plugin
sets up are fine to use for templates, but as | mentioned before, hopefully you'll be customizing

on a per post basis.

Even if you set up templates, you can still customize individual pages/post by filling in the info
in the Yoast SEO box on that individual piece of content. The template just makes sure that your

title and description aren't totally empty.
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SEO > Titles & Metas> Homepage
If your site is set to show Posts on the homepage, you will see this option to set the meta title

and description for your homepage:

Homepage
Title template: % %sitename% % % %page% % % %sep% % % %sitedesc%

Meta description template:
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If you have set a static page for your homepage, you will see this:

Homepage & Front page

You can determine the title and description for the front page by editing the front page itself »

And you will be directed to use the Yoast SEO box on the edit screen of the page itself.
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SEO > Titles & Metas > Post Types

This allows you to set up templates for the output of the meta title and description for every

regular and custom post type on your site.
Meta Robots

Unless you have a specific use-case, you’ll want this set at index. Using an SEO plugin on a site
that is noindexed is pointless since that setting prevents Google crawling your site. A possible

use-case might be a site in development.
Authorship: You can choose to remove the authorship info per post type
Date in Snippet Preview

There are varying schools of thought on this. Generally speaking you would want to show the
date in the snippet preview if you run a news-style site that has time-sensitive content. For other

sites you'll probably want to leave it set to Hide.
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Yoast SEO Meta Box

This is the box that appears on the editing screen for every individual piece of content on your
site, allowing you to customize the meta information for it. 99% of the time you will keep this set

to Show.

If you have custom post types (such as a portfolio, or products for example) they will
automatically show up here and you can customize them just like regular posts and pages. If

your custom post types have archive pages, they will show at the bottom of this screen.

SEO > Titles & Metas > Taxonomies

This tab allows you to control meta information for all the taxonomies on your site such as tags

and categories, in addition to any custom taxonomies generated by themes or plugins.

SEO > Titles & Metas > Archives
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This section pertains to the author and date archives, which WordPress creates by default. The
explanation provided by Yoast on this page is mostly sufficient, but it's worthwhile to note that
if you enable the Author archives, you will then also have the option of enabling a sitemap for

the user archives. That option appears in the XML Sitemaps tab. If you disable Author archives,

that option disappears from the Sitemaps tab.

When using the configuration wizard, the selection you make in Step 7 “Multiple authors” is
related to these options. If you select “yes”, the Author archives will be automatically enabled,

and if you select “no” they will be automatically disabled.

Additionally, you can control the meta info for your search and 404 pages here.

SEO > Titles & Metas > Other

Sitewide Meta Settings

Subpages of archives
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lt's recommended to noindex this to avoid people performing a Google search and ending up
on, for example, page 2 of your archives, which may not be the best place for them to land.
Archive pages change over time as you add new posts - so something that is on page 2 of the
archives today, could be on page 3 tomorrow. It's not ideal to have people land on these
pages because they may not be able to easily find what they are looking for. You want people

to always land on the most relevant page /post for their search and typically that's not an

archive page.

Use meta keywords tag?

This should be Disabled because no search engine uses meta keywords for ranking any more.

Force noodp meta robots tag sitewide

This makes sure that search engines don't use Dmoz meta descriptions for your site, instead of
the meta descriptions you will provide. These directories used to be authoritative guides to the
web but now they are significantly less so, particularly Dmoz, so there's no value in using info
from those listings. You’ll want to set this to Disabled.
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SEO > Social

SEO > Social > Accounts

Enter any profiles associated with your site; they will be utilized for things like Google's
Knowledge Graph. With all things social, you should assume that how these pieces of
information will show up, will change over time. Facebook and Google in particular, constantly
change how they use meta data (for example, Google killing off Authorship). So | recommend

filling in as many details are as pertinent.

For each of Facebook, Twitter, Pinterest and Google+, Yoast SEO can provide all the necessary
social meta info. You should make sure you don't have other plugins duplicating what's being

done here. For example some social sharing plugins might have a similar feature.
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For the more advanced and/or nerdy amongst you, the profiles you add in this section are

output into meta tags on your site.

For example, the Twitter Username you enter ends up in the source code as:

<metaname="twitter:site"content="@yourusername" />

The Facebook Page URL is output as the Publisher tag:
<metaproperty="article:publisher"content="http://facebook.com/yourpage"

/>

At the time of writing it’s unclear how this is being used, but the Author tag is certainly valuable.

See: Personal Social Links
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SEO > Social > Facebook

Add Open Graph meta data
If you have a social sharing plugin that already does this, you can set this to Disabled.

When you (or someone else) shares a link from your site to Facebook, it typically displays with

a title, description and thumbnail:
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Adding a top bar to your WordPress site to improve email opt-ins, is quick
and easy

How to Add a Top Bar MailChimp Opt in on your
WordPress site | Web Training Wheels

It takes less than 15 minutes to set up a top bar MailChimp email sign up for your
WordPress site. Increase subscribers without being annoying.

WEBTRAININGWHEELS.COM
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If your links are not showing up with the correct or desired info, it's probably because you have
not specified your Open Graph info. This is the specific info about a page that Facebook. If you
don't provide it, Facebook is left to its own devices and sometimes that results in random

thumbnails showing up when a URL is shared.

So Yoast can output that info for you, but other plugins also do it, so only enable this option if

you don't already have it in place.

To see if your site is outputting open graph info you can view the source code of your site and

look for the following og tags:

<meta property "oc:imasc" content="http://webtrainingwheels.com/wp-content/uploads/2009/11/droid-search-fb.jpg" />
<meta property="og:title" content="Swiftype &#8211; WordPress Plugin For Enhanced Search"/>

<meta property="og:type" content="article"/>

<meta property="0g:uri  content="http://webtrainingwheels.com/swiftype-wordpress-plugin-enhanced-search/"/>

<meta property="og:site_name" content="Web Training Wheels"/>

<meta property="8grdescription” content="Swiftype is a new WordPress plugin to spruce up the search feature on your site. It's promising but won't be
satisfactory for everyone just yet. " />

Open Graph information

Frontpage settings

This info will be used specifically when someone shares the homepage of your site.
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Default settings

This is the fallback image to be used if the content being shared doesn’t have any images

specified.

Facebook Insights and Admins

At the time of writing, Facebook have disabled new domains signing up for Insights, but you can

use the feature with an existing Insights domain.

SEO > Social > Twitter

Add Twitter card meta data

Twitter now displays links in a similar way to Facebook, with a title and image. If you want to
benefit from that, set this to Enabled. Choose either the summary card, which has a smaller

thumbnail image or summary with large image.
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Summary style:

Truth matters. We’re getting behind journalists. | Po...
T e eeeeas  Postmatic announces a new initiative to support the free
HOES L VENGED  press, the exchange of ideas, and democratization of

democracy. publishing: Postmatic Press. Free WordPress services...
comrmruanity -based, investigative, and ad .
—— gopostmatic.com
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Summary with large image:

E 3 Lucy Beer @webtw - Feb 20
U More email signups, less annoyance: webtrainingwheels.com/how-to-
- add-a-t... #WordPress cc: @ibericode @MailChimp

. |

How to Add a Top Bar MailChimp Opt in on your WordPress site | Web...

It takes less than 15 minutes to set up a top bar MailChimp email sign up
for your WordPress site. Increase subscribers without being annoying.

webtrainingwheels.com
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SEO > Social > Pinterest

Yoast's explanation here is clear ©

SEO > Social > Google+
Google’s Authorship markup, which used to show your profile picture in search results is no

longer used but you can use this tab to connect your site with your Google+ page.

Personal Social Links
A somewhat hidden feature of the Yoast plugin is that it adds social profile fields, for Google+,

Twitter and Facebook, to the Users > Your Profile screen.

If you want to differentiate between yourself (or other users on your site) as an individual, and
your company, yYou can use these fields for your personal social profiles. At least for Twitter and
Facebook these values are added to the social meta data on blog posts IF you've enabled that

meta to be displayed, in the social section.

Twitter:

<metaname="twitter:creator" content="@yourusername" />
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Facebook:

<metaproperty="article:author" content="facebook.com/yourusername" />

If you want everything to be associated with your company and not yourself, you can use your
company page here. This field is important to fill out if, when links are shared on Facebook, you

want a link to your Facebook page included, and a Like /Follow button also embedded.

In the screenshot below, it’s the Author property, when set to your Facebook page, that
produces the “by Ezra Klein” attribution, which links to his Facebook page. The “see more” line

appears after you click the article link from your Newsfeed.
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Tim Ferriss on suffering, psychedelics, and spirituality

Among our topics: why Ferriss fills his home with reminders of his eventual death.

[OX.COM | BYJEZRA KLEIN author markup
See more from Ezra Klein. ife Like
appears after link is clicked
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XML Sitemaps

SEO > XML Sitemaps > General

Having an XML sitemap helps Google find all of the content on your site quickly and efficiently.
The XML sitemap automatically updates as you add new content. This type of sitemap is
designed for bots not humans. Read this post for an understanding of the difference between

XML and HTML sitemaps.

Note that Yoast SEO used to have a shortcode to generate an HTML sitemap, but that feature is

no longer available in the free version of the plugin.

Once you've enabled the sitemap, you should submit the URL to your Google Webmaster Tools
account. Inside Webmaster tools, from the nav menu on the left, click on Optimization, then
Sitemaps. You will see the Add/Test Sitemap button at the top right. Click that and then Submit

Sitemap. Add your sitemap URL and you’re done.
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Post Types / Excluded Posts / Taxonomies

If there are certain post types that you never want to include in your sitemap (because you
don’t want Google to know about them or index them) you can exclude them all here, but you
can also control it individually per post type. For example, | don't usually have a need to

activate the Media sitemap. Nor do | usually need the Post Format sitemap.

Advanced

SEO > Advanced > Breadcrumbs

Breadcrumbs are navigational aids that help humans orient themselves within a site —
understanding what section or sub-section they are in. They also provide help to bots in
discovering all the content on your site. For most personal blogs, or small sites, breadcrumbs

wouldn’t really be necessary. But if your site has a more complex structure that goes several
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sub-sections deep, or provides many ways to get to the same content, as many ecommerce sites

do, for example, you may find them useful. This is what breadcrumbs look like:

« Back | Home » Shoes > Sneakers & Athletic Shoes » Emerica » Laced by Leo

All of the options in this section let you customize how you want your breadcrumbs to look and
where on the site you want them to show up. However, unless you happen to be using one of a
handful of themes that natively support Yoast’s breadcrumbs (Thematic and Hybrid are
examples), you will have to add the code that Yoast provides into your theme. Consult this

article: https: //kb.yoast.com/kb /implement-wordpress-seo-breadcrumbs/

If you are a beginner uncomfortable with code, this would not be recommended. You would be
best not bothering with this section. You can check if your theme has its own method of

breadcrumbs built-in — many do.

SEO > Advanced > Permalinks
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This is fairly advanced stuff - most users will not have need for it and can use the default

settings. Yoast's comments are pretty well detailed here.

SEO > Advanced > RSS

RSS feed settings

This is a useful feature Yoast has provided to foil scrapers (dodgy sites that automatically
republish content from other sites without permission). They work by scraping, i.e. copying, the
content of your RSS feed, so Yoast provides a way for you add a footer or header to your
feed which contains links back to your site. This way, even if someone does scrape the content,

at least you will be credited. If you’re not sure what to do here, just leave the default settings.

Tools

SEO > Tools > Bulk Editor
This provides a handy way to edit the SEO titles and meta descriptions for your content on one

screen, without having to go into each individual edit screen:
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SEO > Tools > File Editor

WordPress dynamically generates a virtual robots.txt file, but if you manually created one, you

could edit it here.

You can also edit your htaccess but you should only do that if you know exactly what you are
doing. For advanced users you can use htaccess to do redirects, security tweaks and more. It
wouldn’t really be advised to make changes from within the dashboard, but this tool can be
useful to easily view the file if you don’t (for some reason) have FTP access. Generally

speaking, non-technical users should ignore this section.
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SEO > Tools > Import & Export

So let’s say you've been using some other SEO plugin on your site for a long time and now
everyone is telling you to use Yoast’s plugin. Will you have to start from scratch or lose all that
meta data you already input in your other pluging NO! Yoast provides an import feature here
which allows you to move your exiting meta information from another plugin into WordPress
SEO so that you don’t have to re-do everything. Likewise you can also export all of your Yoast

data here as well.
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Search Console

The Google Search Console integration enables you to see any reported crawl errors right
inside your WordPress site. If you have the Premium version of Yoast SEO, you'll be able to set

up redirects to resolve 404s, directly from this screen.

For the full range of information available, besides crawl errors, you should still log in to Search

Console directly every so often.
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Those are all the main plugin settings, as found under the SEO menu tab.

However, you'll also find Yoast SEO meta boxes on individual posts, pages, categories etc This
is where you'll be most frequently interacting with the plugin, and what requires more of your

time and attention.

Managing Meta Data for Individual Pieces of Content

Posts, Pages, Custom Post Types, Taxonomies

You will see the following box at the bottom of each piece of content you are editing:
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Yoast SEO

© Help center v

“Web

Linin
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W Go Premium

| D @® Readability @ Enter your focus ke... +

<
2

@& Snippet preview

Your Financial Vision - WordPress Playground
www.wordpress.dev/your-financial-vision/ v
Cupcake ipsum dolor sit amet dessert. Fruitcake sweet pastry jelly-o jelly-o halvah. Jelly apple pie

danish caramels liquorice bonbon jelly beans dessert fr

# Edit snippet

&, Focus keyword

i= Analysis

@ No focus keyword was set for this page. If you do not set a focus keyword, no score
can be calculated.

@® No meta description has been specified. Search engines will display copy from the
page instead.

@ No images appear in this page, consider adding some as appropriate.
@ The slug for this page contains a stop word, consider removing it.
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Content Optimization

Earlier in this article | talked about how the plugin allows you to create a template for
your meta title and description, but that you may want to customize it on a per-post

basis. This is where you would do that.

Snippet Preview

If you set up a meta information template in the SEO > Titles & Metas section you'll already see
some information populated in the Snippet Preview area. This gives you a preview of how your
post will look in the Google results pages, based on your current settings. You will notice that if

you start typing something into the SEO Title or Meta Description fields, the snippet preview will

change in real time to reflect the new information you are providing.

Everything should be written in human-friendly English (no lists of keywords or other tricks). The

title should have your keywords for that post/page in it.

The description is like ad copy - a compelling description of the content that will encourage

people to click on your result in the search results.
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This is useful since in some cases you may have crafted a clever or funny post title for your
readers, but that may not be the most search-engine friendly way of describing it. So the SEO

title lets you give Google a more straightforward title.

Focus Keyword

Many people on first glance get hung up on or confused by this field. Here's what you have to
understand - this is only a tool, and does not affect the output of the code on your site. Only the
actual content of your page does that. If you leave this field blank, it will have no adverse
effect. If you are already competent at SEO you will not need this tool, but it may be helpful

for beginners.

If you enter a focus keyword (that's one keyword or one phrase) for your post, then after saving
the page you will see an analysis of the content which lets you know how well (or not) you've

optimized this content for your given keyword.

The value for beginners is in reading the analysis, which will help you understand what it

expects from you to optimize your content.

Need to learn SEO fundamentals? The Beginner's Guide to SEO for Business 56
Get 50% off with this coupon code: YOASTSEO



http://webtrainingwheels.com/beginners-guide-to-seo-ebook/

The Complete Guide To Using The Yoast SEO Plugin

&, Focus keyword

financial vision

Analysis

No meta description has been specified. Search engines will display copy from the page
instead.

The focus keyword doesn't appear in the first paragraph of the copy. Make sure the topic is
clear immediately.

No images appear in this page, consider adding some as appropriate.

The keyword density is 0%, which is too low; the focus keyword was found 0 times.
The slug for this page contains a stop word, consider removing it.

No links appear in this page, consider adding some as appropriate.

The SEO title contains the focus keyword, but it does not appear at the beginning; try and
move it to the beginning.

The page title is too short. Use the space to add keyword variations or create compelling
call-to-action copy.

The focus keyword appears in the URL for this page.

The text contains 300 words. This is more than or equal to the recommended minimum of
300 words.

You've never used this focus keyword before, very good.
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Preview Changes
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@ Visibility: Public Edit
¥O Revisions: 2 Browse
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Edit
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The color indicator at the top of the tab and in the Publish
box shows you well you're doing. Don't obsess about
making it furn green however; you never want to sacrifice
well-written content for the sake of search engine

optimization.

Each post or page should be tightly focused around one
concept- that's why you only enter one word or phrase for
this to work. If you don't know what to put it means you may

not have a clear direction with this piece of content.

You only need to enter a focus keyword if you want to utilize the page analysis tool.
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Social
You will only see this tab if you enabled it in the main Social settings of the plugin.

The Social tab allows you to specify the title, short description and an image, to be displayed
when your content is shared on social media. If you don't specify this info, whatever you have
created for your title and meta description will be used as the snippet, and the image could be
random, depending on what images are found on your page, how big they are etc. To have full

control over how your links will look when shared, you should specify all the information here.

Advanced
If enabled, this tab gives you control over the robots meta tag for the page/post,

allowing you to specify if the page should be noindex-ed and/or nofollow-ed. This
isn’t a commonly used setting; a typical use case might be if you are creating a landing page

that you don’t want to show up in search results.
You can also control the canonical url for the page.

If you don’t know what any of these settings relate to, you would be advised not to change

them!
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All Posts / All Pages screen

After activating the plugin, you will see some new columns show up on the All Posts and Al

Pages screen.

Readabili Meta Focus
Title Author Categories Tags | Date SEO ty SEO Title pesc. KW
Lightwei lucyb SEO — — Published ® ® Lightweig — — =
ght Grid 2016/09/17 ht Grid
Columns Columns

WordPres
s
Playgroun
d

This can clutter up the screen and make it harder to read. To remove some or all of them, simply

go to screen options and un-check the ones you want to hide.
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Columns

V| Author |V/| Categories |v/| Tags [v| Comments |v/| Date | [/ SEO |v| Readability [v/| SEO Title

|v| Meta Desc.

Focus KW

Pagination
Number of items per page: 20
View Mode

e List View Excerpt View

Apply

Posts Add New
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Thanks for reading! If you found this guide useful, drop a comment on the blog, Tweet it to your

friends or drop me an email: lucy@webtrainingwheels.com !

If you need to learn more about the fundamentals of search engine optimization, check out my

ebook:
The Beginner’s Guide To SEO For Business:

http: //webtrainingwheels.com /beginners-guide-to-seo-ebook /

Get 50% off with this coupon code: YOASTSEO
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